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PREFACE 

In my time advising graduate students in the Department of Music at Wayne State 

University, I’ve noticed that many regard the thesis project with dread. Not only is it a big project, 

but it’s also often perceived to be shrouded in mystery, apprehension, and anxiety. After all, it’s 

not like a recital, where you can decide exactly which pieces to focus on for months in advance, 

perform them, and then consider the requirement satisfied. During the preparation process, a thesis 

is less clearly defined: students sometimes don’t know what to write about, how to write about it, 

and how to create and work with what may be the longest paper they’ve ever written. My hope is 

that, by consulting this guide, students can escape some of the dread and, instead, focus on doing 

their best work. 

This document offers guidance regarding the process, content, and formatting of a music 

thesis to those students in the Wayne State University Department of Music who are required to 

write one for their graduate degree. The WSU Graduate School offers its own guide for theses and 

dissertations, and a lot of the information contained here comes from that one. While the Graduate 

School defers to colleges and departments regarding many aspects of the thesis document, if a 

conflict arises between this guide and that one, the Graduate School’s document will take 

precedence. Moreover, the final authority regarding academic degrees at Wayne State University 

rests in the text of the Graduate Bulletin. 

Within this guide, I’ve followed several conventions you may find useful: 

• Blue color is applied to text to indicate you are reading instructions for how to 

accomplish a task in Microsoft Word. (Links are also blue, but they’re also underlined.) 

• Bold text is used (most of the time) to indicate a technical term. 

• Highlighting is used to draw your attention to a specific recommendation. 

https://gradschool.wayne.edu/
https://gradschool.wayne.edu/final_requirements/format_guidelines.pdf
https://gradschool.wayne.edu/final_requirements/format_guidelines.pdf
https://bulletins.wayne.edu/
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• This guide is thoroughly cross-referenced. Most times you see “Figure,” “Table,” 

“Chapter” or a phrase from a heading in the text, you can click on it—it’s actually a 

link—to go directly to the page where that figure, table, chapter, or heading is located. 

 

It is strongly recommended that you write your thesis using Microsoft Word on your 

computer. It is among the most powerful word processors available (even if most users don’t 

actually use its most powerful features) and contains all the necessary tools to properly write, 

revise, compile, and format your thesis. This guide assumes you are using Microsoft Word. 

All students at Wayne State University can download a complete and current copy of 

Microsoft Word for free, along with the entire collection of Microsoft Office products.1 While 

Word is also available as part of the online Microsoft365 suite, you should not use the online 

version of Word for your thesis as it lacks some of the necessary features. Students who lack a 

computer are welcome to use the computer labs on campus and may also check out a computer 

from the libraries. Additionally, the WSU Library System maintains an Accessible Technology Lab 

for students who might benefit from accessibility hardware and software. 

Finally, this is a “living” document, one intended to be regularly updated. If you spot an 

inaccuracy or a confusing passage, please let me know so I can fix the error or improve the clarity 

in a future version. In the meantime, good luck with your thesis! 

 

Sincerely, 

Dr. Duchan 
Director of Graduate Studies 
July 2023 

                                                 
1 For more information about Microsoft Office for WSU students, and for download links, see 

https://tech.wayne.edu/software-hardware/microsoft-office. 

https://library.wayne.edu/services/computing/labs/
https://library.wayne.edu/equipmentcheckout
https://library.wayne.edu/services/computing/accessible-technologies
https://tech.wayne.edu/software-hardware/microsoft-office
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CHAPTER 1  

The Thesis-Writing Process 

Congratulations on making it to the point where you’re ready to begin your thesis! Writing 

a thesis can be an exciting and enlightening process, and it doesn’t have to be overly difficult. The 

key is planning and consistency, making sure you establish a regular routine of research, writing, 

and discussions with your Thesis Advisor. As the old adage goes, “slow and steady wins the race.” 

Each thesis project is unique, and although it’s intended to be completed over two semesters, it is 

not unusual for some students use more time if they have other family or work commitments. 

Ideally, you’ll find a balance between high-quality academic work and extracurricular life. 

When you write a thesis in the Wayne State University Department of Music, you’re 

expected to produce a rigorous, well-researched, and original study. While you will certainly refer 

to extant research, a thesis isn’t simply a report on what has already been written. Rather, it expands 

our knowledge about music, even if in a small way. Your thesis can ask new questions of an old 

piece of music, ask old questions of a new piece of music, critique an existing method or theory 

or historical narrative, provide new evidence in support of a method or theory or historical 

narrative, and so on. The possibilities are endless. 

But that doesn’t mean you have to rewrite the entire history of music! While you’ll 

contextualize your work within the broader narrative of music history, most of your thesis will 

focus squarely on your particular topic. There is no minimum page requirement for theses in the 

Department of Music. Quality is more important than quantity. (That being said, most music theses 

end up between 100–125 pages.) 
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Your Thesis Advisor and Committee 

The faculty member with whom you work most closely on your thesis project is called 

your Thesis Advisor. He or she must be a member of the department’s full-time faculty. Since 

there will be a good deal of communication between you, it’s often best to select a faculty member 

with whom you already have a good professional relationship. Also important is that faculty 

member’s research expertise. It’s helpful, but certainly not required, if your Thesis Advisor’s 

research interests align with your thesis topic. 

As you approach the end of the thesis project, your Thesis Advisor will ask you to assemble 

an Examining Committee, a panel of faculty (including the Thesis Advisor) who will read your 

thesis and conduct your Final Oral Examination (also called the “defense”). Consult the 

department’s Graduate Student Handbook for information for important details. 

Choosing a Topic 

A topic isn’t the same thing as your thesis statement. For example, your thesis statement 

might read, “Mozart composed sad music when it was raining,” but the topic of your thesis might 

be described as “Mozart’s compositions and the environment.” The thesis statement is a claim 

you will prove is true, while the topic is a more general idea that can encompass the claim you 

make in your thesis statement. 

It is recommended you choose a topic for your thesis that is appropriate, that you’re excited 

about, and that is well supported by extant scholarship. 

An appropriate topic is one that pertains to the study of music. This definition is necessarily 

vague, and it’s the responsibility of the student to justify whatever topic he or she selects. It’s up 

http://music.wayne.edu/students/graduate_student_handbook2020-11-11_.pdf
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to your Thesis Advisor to determine if your topic, as described in your Thesis Proposal (see 

“Writing a Thesis Proposal,” below), is appropriate. 

You should also choose a topic you’re excited about. After all, you’ll be spending a good 

deal of time working on it. Do you enjoy listening to the music? Thinking about it? Reading about 

it? Analyzing it? You should answer these questions positively or you’re more likely to grow bored, 

distracted, and tempted to abandon the project. (You’ve come this far, don’t give up now!) While 

you can’t predict the future with perfect accuracy, you are the best person to determine if a topic 

is likely to sustain your interest and enthusiasm. 

Finally, a topic on which there is a good deal of extant scholarship will be easier to write 

about than one without such literature. This means you should do a little bit of research about your 

topic before deciding to pursue it. Are there any scholarly books or journal articles about it? It’s 

helpful if the answer is yes, but even if the answer is no, that’s not a reason to abandon the topic. 

You just have to confirm that there’s sufficient scholarship on tangential topics, so you can place 

your study alongside earlier ones and still argue that you’re doing something new. For example, if 

you’re hoping to write a thesis about a particular symphony, but you’re finding very few books 

and articles that mention it (or none at all), you can expand your search to look for sources that 

discuss the composer, the compositional techniques, or other matters of context. In fact, not finding 

any sources that directly address your proposed topic can help to justify your research and 

underline your original contribution to knowledge. As with the issue of appropriateness, it’s up to 

your Thesis Advisor to determine if your topic, as described in your Thesis Proposal, is sufficiently 

supported by extant literature—but you’re the one who must supply the bibliography listing that 

literature. 
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Writing a Thesis Proposal 

A Thesis Proposal is a document (usually 4–6 pages) in which you describe the topic you 

intend to study, the research question(s) you’ll ask and answer, how you’ll do it, and offer a 

preliminary overview of some of the most important sources you’ll consult. Writing the Thesis 

Proposal is supposed to be helpful: it allows you to concretize your thoughts and make preliminary 

decisions about how to start the project. And much of the text can be reused later in the thesis 

itself! An important thing to keep in mind, however, is that what you write in the proposal is not 

“set in stone.” The research and writing process is fluid, and your Thesis Advisor will understand 

if your project turns in a new direction, asks different questions, or comes to different conclusions. 

The first thing to do when writing a Thesis Proposal is to talk with your Thesis Advisor 

about his or her expectations for it. See Table 1.1 for a list of components that usually make up the 

proposal. 

 

1. A general introduction to the topic, which should generate some interest from the 
reader. 

2. A statement of the research question: the question you seek to answer or the problem 
you seek to solve. 

3. An overview of your sources. What will you look at in your offers to answer the 
research question? Musical scores? Recordings? Transcriptions? Newspaper or 
magazine articles? Online videos? 

4. A discussion of the methods you’ll use to answer the research question. Will you be 
analyzing scores? recordings? interview transcripts? survey responses? collections of 
letters or other correspondence? Importantly, how will you analyze them? 

5. An overview of relevant extant scholarship. What has already been published in peer-
reviewed books and journals that bears some relevance to your topic, the things you’ll 
be analyzing, and the analytical methods you’ll be using? You don’t need a detailed 
literature review at this point—that will come later—but you should demonstrate 
enough familiarity with the sources to make a convincing case that your work will fit 
into the larger world of music research. 
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6. A discussion of your expected results. This is your tentative thesis statement. What 
do you predict your answer or solution will be? Remember, it’s okay if the final 
version of your thesis comes to conclusions that differ from those you predicted in 
your proposal. But it’s important to begin the thesis project with some sense of 
direction. 

7. A brief argument for the significance of your project. What justifies your research 
question? How will your thesis add to our society’s knowledge about the topic you’ll 
be investigating—and about music, more generally? 

8. A bibliography listing any and all of the sources you cite in the proposal. 
Table 1.1. Components of the Thesis Proposal 

It might be useful to format your proposal using the same guidelines as those for the thesis 

itself. That will make the actual writing of the thesis easier. For more information about formatting 

requirements, see Chapter 3. 

Once your Thesis Advisor has approved your Thesis Proposal, you can begin your research 

and writing. You may find it useful, at this stage, to map out a tentative table of contents and a 

timeline to help structure the project and break it into smaller, more manageable tasks. Work with 

your Thesis Advisor to establish a mutually acceptable schedule for what you’ll deliver to him or 

her, how you’ll deliver it, and, crucially, when you’ll deliver it. 

Conducting Research 

“Conducting Research” is a broad label that includes gathering sources, reading secondary 

scholarship, examining primary literature, performing analyses, etc. There’s no “one-size-fits-all” 

way to do it. Therefore, you must discuss the tasks you’ll undertake with your Thesis Advisor. 

The more information you gather, the better. Take careful notes, follow leads, cast a wide 

net, and so on. Try to come up with a way to organize the information you gather. For example, 

you can create one folder on your computer for “notes on secondary sources,” another for “scores 
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and analyses,” etc. That way, when it comes time to start writing the thesis, you’ll know where to 

find all your information. 

Some students find notetaking and citation apps helpful. Others prefer to simply use a Word 

document for each bit of information. And others like writing things down by hand, even if they 

will need to be typed into a computer later. Find the method that works best for you. 

Kate Turabian’s A Manual for Writers of Research Papers, Theses, and Dissertations and 

C.M. Gill’s Essential Writing Skills for College and Beyond contain a lot of helpful suggestions 

for planning, carrying out, and writing up research.1 You may have read some of those chapters in 

MUH 5300 (Music Research), but now might be a good time to review them for additional 

guidance and suggestions. 

Writing and Revising Chapters 

Rather than thinking about sitting down and writing a whole thesis, many students find it 

less intimidating and more helpful to think about each chapter as a term paper. After all, by the 

time you get to the thesis project, you will have taken several graduate seminars and submitted 

several term papers, so the idea of a ten-, twelve-, or even twenty-page paper is probably less scary 

than it once was. Thinking about your thesis as a collection of term papers turns a gigantic project 

into a series of more manageable—although still significant—ones. 

When you’re ready to start drafting chapters, you may find it helpful to devise a tentative 

table of contents and timeline with your Thesis Advisor. Or, if you already did that, to review and 

                                                 
1 Kate L. Turabian, A Manual for Writers of Term Papers, Theses, and Dissertations, 9th ed. (Chicago: University of 

Chicago Press, 2018), C.M. Gill, Essential Writing Skills for College and Beyond (New York: Writer’s Digest 
Books, 2014). 
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revise it. How can all your data and analyses and arguments be most effectively organized? Which 

point will each chapter prove? Most music theses tend to take a similar form (see Table 1.2): 

 

Chapter(s) Purpose Includes 

first chapter the introduction to the thesis • general introduction to the topic 

• discussion of the research question 

• thesis statement (your answer to the 
research question) 

• discussion of the sources consulted and 
analyzed (in other words, the literature 
review) 

• discussion of the analytical methods used 

• discussion of the significance of the work 

middle chapters advance your argument—your answer to 
your research question—step by step2 

• presentation of information (your data) 

• analyses and their results 

• other evidence to support your conclusion(s) 

final chapter your conclusion and parting thoughts • brief recaps of the middle chapters, showing 
how their arguments connect to each other 
and support the overall thesis statement 

• discussion of how the thesis adds to current 
research and knowledge 

• discussion that speculates as to the impact 
the conclusions may have 

• suggestions for future research 

Table 1.2. Common form of the body of the thesis. 

Typically, you’ll draft one chapter at a time, and then share it with your Thesis Advisor, 

who will offer feedback. Sometimes this is done through Microsoft Word’s “Track Changes” 

feature, a face-to-face or virtual meeting, or both. Revisions are commonly requested, and are 

usually made right away, while the ideas are still fresh. Once the Thesis Advisor is satisfied that 

                                                 
2 In theses that focus on a single person, oftentimes the second chapter offers a lengthy biography, and the following 

chapters present the evidence and argument. 
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the chapter is “good enough,” you move on to another chapter. It is recommended that you keep 

each chapter draft as a separate Word document on your computer, and that you back up your work 

to another location.3 

Most students start by drafting the middle chapters, leaving the first and last for the end of 

the writing process. Be sure to keep your citations up to date as you write so you don’t have to go 

back and figure them out later. And remember, in the Department of Music, we use the 

Chicago/Turabian style (notes-bibliography version) for all citations. 

Most important: do the best you can in the time you’ve got. Perfection is impossible, and 

at some point, your improvements will be so small that they’re no longer worth the time you put 

in. Aim for “good enough” so that you have sufficient time for all the parts of your thesis. You may 

hear some faculty say, “a good dissertation is a done dissertation,” which holds true for theses too! 

Compiling a Complete Draft 

Once all your chapters are drafted, you’ll compile them into a single document in Word. 

You’ll probably want to start by creating a new, blank document and copying-and-pasting the 

contents of each of your chapters from their original files into it. Before doing so, you may find it 

helpful to adjust some settings pertaining to Styles to make formatting easier. See Chapter 3 for 

details. 

As you continue to work on your thesis from this point forward, use your new, combined 

document. It may be helpful to save it as a new file each time you make substantial changes, so 

                                                 
3 Wayne State University offers all students access to Microsoft’s OneDrive service, where you can store backup 

copies of your files. For more information about OneDrive at WSU, see 
https://tech.wayne.edu/kb/communication-collaboration/wayne-connect/154658. Of course, you are not required 
to use OneDrive; other cloud backup services may serve the same purpose: to keep a copy of your work in the 
event your primary copy (on your computer) becomes unusable or inaccessible. 

https://tech.wayne.edu/kb/communication-collaboration/wayne-connect/154658
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you can go back to previous versions if necessary. For example, if your thesis document is named 

“Thesis.docx,” and then, on March 6, you make a lot of edits and changes, you may wish to save 

it as a new file, “Thesis 2023-03-06.docx” or something similar. Depending on the configuration 

of your computer, previous versions of the file may be saved automatically.4 

The Final Oral Examination (Your “Defense”) 

After your thesis is compiled, completed, and ready for the members of your Examining 

Committee to read, you’ll need to send it to them at least two weeks in advance of your Final Oral 

Examination (your “thesis defense”). You’ll also need to schedule the defense at a mutually 

agreeable time and reserve a space in the department for it (or set up the virtual meeting). During 

the defense, you’ll offer a presentation and then participate in a discussion with the members of 

your committee. Your thesis may then be accepted as written, accepted pending revisions, or not 

accepted. The most common outcome for a defense is “accepted pending revisions.” You will also 

receive a “Final Oral Exam Report” from your committee with written feedback. Be sure to read 

the Graduate Student Handbook for the more information about the Final Oral Examination. 

Final Revisions and Submission 

As most thesis defenses end with acceptance pending revision, you’ll likely be required to 

make some additional changes before your thesis is “done.” Typically, these include some editing 

                                                 
4 For information from Microsoft regarding the “previous versions” feature, which may require use of OneDrive, see 

https://support.microsoft.com/en-us/office/view-previous-versions-of-office-files-5c1e076f-a9c9-41b8-8ace-
f77b9642e2c2. 

http://music.wayne.edu/students/graduate_student_handbook2020-11-11_.pdf
https://support.microsoft.com/en-us/office/view-previous-versions-of-office-files-5c1e076f-a9c9-41b8-8ace-f77b9642e2c2
https://support.microsoft.com/en-us/office/view-previous-versions-of-office-files-5c1e076f-a9c9-41b8-8ace-f77b9642e2c2
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of the language, additional discussion of certain points, clarifications, adjustment of citations, etc. 

In most cases, the revisions can be completed within about two weeks. 

After you’ve made the requested revisions, you need only send the final version of your 

thesis manuscript to your Thesis Advisor, who will verify that the revisions are acceptable. Once 

approved, you may submit the thesis to the Graduate School for their format check and archiving.5 

                                                 
5 For more information about the final steps of thesis submission, see 

https://gradschool.wayne.edu/students/masters/requirements. 

https://gradschool.wayne.edu/students/masters/requirements
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CHAPTER 2  

Parts of the Thesis Document 

While a music thesis can focus on nearly any topic, there are certain elements that must be 

included regardless of the particular focus. These demonstrate your academic rigor and research 

skills, while also helping to make research easier for future scholars, who will know which pieces 

of information will be found in which parts of any thesis. See “Writing and Revising Chapters” for 

more information about the order and contents of your thesis chapters and body text. 

A complete thesis manuscript consists of several specific parts. Some are required, while 

others are optional. Table 2.1 shows the parts of the thesis in order. The content of each part is 

discussed below; the formatting for each part is discussed in Chapter 3. 

 

Section Part Components See… Pagination 

front 
matter 

title page thesis title, author’s name, degree, 
thesis Advisor’s name and signature Figure 3.1 

none 
copyright page indicates copyright Figure 3.2 

dedication brief indication of the person(s) to 
whom the thesis is dedicated 

 

starting with “ii” 
at bottom center 

of each page 

acknowledgments 
prose passage detailing those the 
author acknowledges for their help or 
influence 

 

preface or foreword introductory text setting up the thesis 
project as a whole 

 

table of contents listing of all chapters (and, optionally, 
headings) and page numbers Figure 3.3 

list of tables listing of all tables in the thesis, if 
appropriate 

 

list of figures1 listing of all figures in the thesis, if 
appropriate Figure 3.4 

                                                 
1 This item may also be called a List of Maps, Charts, Diagrams, or Schemes, as appropriate. 
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Section Part Components See… Pagination 

body body text the text of the thesis, organized into 
chapters Table 1.2 

starting with “1” 
at top center of 

each page back 
matter 

appendix additional materials, if appropriate  

bibliography listing of all sources cited in the body 
text Figure 3.5 

abstract brief prose description of the thesis Figure 3.6 

autobiographical 
statement 

brief prose containing biographical 
information about the author 

 

Table 2.1. Parts of the thesis. Bold indicates a part is required. 

The Title of Your Thesis 

The title of your thesis appears on the document’s Title Page, and is required. It should be 

descriptive of the thesis as a whole, indicating the main topic of your research. Oftentimes, the title 

is presented in two parts, separated by a colon. The first is a brief quote or catchy turn of phrase, 

while the second is more technical and specific. For example, “The Power of a Flying Pig: Carl 

Stalling, Looney Tunes, and America’s Need for Escape.” Others prefer a simpler, more direct title, 

such as “The Guitar Voice of Randy Rhoads.” 

You should come up with a tentative thesis title while you’re planning your project—and 

include it in your Thesis Proposal—you should also remain flexible and willing to adjust it as 

necessary to reflect the evolving nature of your project. See “Title Page” for formatting 

requirements. 
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Asserting Your Copyright 

As an original work, your thesis is technically under copyright the moment you create it in 

a “fixed” form, according to the United States Copyright Office.2 However, you can assert your 

copyright by including an optional copyright page in your thesis, which includes your name, the 

year the thesis is completed, and the copyright symbol. See “Copyright Page” for formatting 

requirements. 

Opening Remarks: Dedication, Acknowledgements, and Preface or Foreword 

These sections are optional and, if included, should appear on separate pages in the order 

shown. The dedication is a brief note naming a person or persons in whose honor or memory the 

works was completed. Acknowledgments are notes of appreciation for assistance given in the 

research and preparation of the thesis. A preface or foreword may contain your statement of the 

purpose of the study or special notes to the reader. See “Dedication, Acknowledgements, and 

Preface or Foreword” for formatting requirements. 

The Map: Table of Contents 

Every thesis must have a table of contents, which shows nearly all the parts of the 

manuscript, and on which page each part begins. Specifically, it lists all the preliminary pages 

(front matter) except for the title, copyright, and table of contents pages. In cases where there are 

two or more appendices, list each appendix and its content. The table of contents must also list the 

                                                 
2 For more information about copyright and United States copyright law, see https://www.copyright.gov/what-is-

copyright/. 

https://www.copyright.gov/what-is-copyright/
https://www.copyright.gov/what-is-copyright/
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bibliography, abstract, and autobiographical statement pages. A “leader” of periods (dots) connects 

the titles of each item in the list (left justified) with its respective page number (along the right 

margin). See “Table of Contents” for instructions and formatting requirements. 

More Lists: Lists of Tables, Figures, etc. 

When tables, figures, or charts have been placed in the body of the manuscript (not in the 

appendix), separate lists must be included after the table of contents page. If your document 

includes both tables and figures, you will need a List of Tables and a List of Figures. Each entry 

on the lists should carry the same caption or title as is shown in the caption for the corresponding 

figure or table in the body text, and show, at the right margin, the page on which it is found (similar 

to the table of contents). See “Lists of Tables, Figures, etc.” for instructions and formatting 

requirements. 

The Main Act: The Body of the Thesis 

The body of your thesis—often called the “body text”—is where you present and develop 

your main argument, the “thesis of the thesis” or thesis statement, over several chapters. It often 

begins with an introductory chapter and ends with a conclusion. Your evidence and analyses are 

methodically laid out in the chapters between. See Table 1.2, in “Writing and Revising Chapters,” 

for additional details. 

For More Info: Appendix 

An appendix contains additional material that is important enough to be included but 

cannot be placed within the body text because it’s too lengthy or tangential. An appendix isn’t 
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required, and you may use more than one appendix if you wish; simply title them “Appendix A, 

B, C, etc.” See “Appendix” for formatting requirements. 

Cite Your Sources: Bibliography 

The bibliography (sometimes called “references” or “works cited”) is a required 

component of your thesis. It contains a list of all the sources cited in your body text, and only the 

sources cited in your body text. If you read a book or article but didn’t end up citing it in your 

thesis, then it shouldn’t appear in your bibliography. In most cases, all of the sources are combined 

into a single bibliography, no matter the type. However, especially lengthy bibliographies can 

sometimes be broken into two or three by type. For example, you might have one list of interviews, 

another list of scholarly articles and books, and a third for articles from the popular press. Consult 

your Thesis Advisor if you think your bibliography would benefit from being separated similarly. 

Bibliographies should be composed using the Chicago/Turabian style (notes-bibliography 

version). See “Bibliography” for additional requirements. 

In Short, Your Abstract 

Your abstract is a brief prose summary of your thesis project, including methods, findings, 

and their significance. It is a required part of the thesis, and a useful one, too: when future scholars 

are conducting their own research on the same topic—for a class term paper, a master’s thesis, or 

perhaps even a dissertation or monograph—they can read your abstract to quickly gain a sense of 

what you accomplished in your study. While there’s no limit to the length, most abstracts contain 

no more than five hundred words. See “Abstract” for formatting requirements. 
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About the Author: Autobiographical Statement 

This required component of your thesis is a one-page biography of the author—you! This 

section may be formatted however you see fit (save for the title at the top, which must be formatted 

the same as the chapter titles), but it can only be one page, and it’s the last page of the thesis. See 

“Autobiographical Statement” for additional requirements. 
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CHAPTER 3  

Issues of Formatting 

Although the issues discussed in this chapter are rather technical, following these 

recommendations will ultimately make your thesis document easier to work with and better 

looking. Indeed, this guide follows the same guidelines, so you can use it as a model. 

Working with Files 

When writing the initial draft of each chapter, it is recommended that each be its own, 

separate Microsoft Word document (.docx) file. That will make it easier to focus on the individual 

chapter without the distraction of other parts of the document getting in your way. It will also be 

helpful when you share your work with your Thesis Advisor. You may choose to format your 

chapter drafts using the guidelines from the Graduate School and the Department—and doing so 

will save time later on—but it is not required at the drafting stage. See “Writing and Revising 

Chapters” for more information. 

Once most or all your chapters are ready, your Thesis Advisor will instruct you to combine 

the individual documents into a single document. At this point (if you haven’t already), you should 

begin to the follow the formatting requirements. Doing so will make it easier to manage a large 

document using Word. See “Compiling a Complete Draft” for more information. 

Showing Formatting Marks 

When working with formatting in Word, it’s helpful to turn on the feature that shows you 

the formatting marks, including all spaces, paragraph breaks, page breaks, etc., using a blue color 
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to differentiate them from the actual text of your document. In the “Home” tab of the ribbon, look 

for a button with a paragraph symbol (¶).1 Clicking it will toggle the formatting marks on and off. 

Introducing Styles 

One of the most overlooked, but useful and timesaving, functions in Word is Styles,  

collections of formatting commands that can be applied with a single click. They ensure that all 

your chapter titles, headings, subheads, etc. look the same across the entire thesis manuscript and, 

if you format the Style correctly, then they will also be formatted correctly. 

You can access Styles in two ways: by using the menus or the ribbon. 

 

• Using the menus: Open the “Format” menu at the top of the screen and select “Style…” 

A box will open, showing a list of Styles are that already available and several options 

for creating new ones and modifying existing ones. 

• Using the ribbon: On the “Home” tab of the ribbon, click on the button that says, “Styles 

Pane,” which is often located next to a small selection of frequently used Styles.2 

                                                 
1 The “ribbon” is Microsoft’s term for the horizontal strip of buttons near the top of the window. 

2 This method assumes you are using the default layout of the ribbons. If your version of Word has been customized—
adding, removing, or rearranging buttons in the ribbons—then this button may not appear or may appear in a 
different location. 
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Preparing Your Styles 

The first step is to prepare the various Styles you’ll use in your document by defining them, 

specifying all the formatting you need to be applied every time you use that style.3 When setting 

up your Styles, it is recommended that you modify Word’s default Styles (which use the same 

names as those shown on Table 3.1) using the parameters listed, rather than creating new Styles. 

Here’s how to modify and create Styles: 

 

Using the “Style” box: 

• To modify an existing Style, select it by clicking on its name in the list on the left side 

of the box. Then, click on the button that says “Modify…” 

• To create a new Style, click on the button that says “New…” 

 

Using the “Styles Pane”: 

• To modify an existing Style, select it by moving the mouse pointer over it, clicking on 

the downward pointing arrow, and clicking “Modify Style…” 

• To create a new Style, click on the button that says “New Style…” 

 

For most music theses, you only need to be concerned with the groups of formatting 

commands associated with “Font” and “Paragraph.” Regardless of how you access Styles, you’ll 

be able to adjust these settings by opening the “Modify Style” box. When it first opens, it shows 

the group of formatting commands associated with “Font.” They should look like the buttons used 

                                                 
3 For more information about working with Styles in Word, see https://support.microsoft.com/en-gb/office/customize-

or-create-new-styles-d38d6e47-f6fc-48eb-a607-
1eb120dec563#:~:text=Right%2Dclick%20the%20text%20on,appear%20in%20the%20Styles%20gallery. 

https://support.microsoft.com/en-gb/office/customize-or-create-new-styles-d38d6e47-f6fc-48eb-a607-1eb120dec563#:%7E:text=Right%2Dclick%20the%20text%20on,appear%20in%20the%20Styles%20gallery
https://support.microsoft.com/en-gb/office/customize-or-create-new-styles-d38d6e47-f6fc-48eb-a607-1eb120dec563#:%7E:text=Right%2Dclick%20the%20text%20on,appear%20in%20the%20Styles%20gallery
https://support.microsoft.com/en-gb/office/customize-or-create-new-styles-d38d6e47-f6fc-48eb-a607-1eb120dec563#:%7E:text=Right%2Dclick%20the%20text%20on,appear%20in%20the%20Styles%20gallery
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for common formatting commands in the “Home” tab of the ribbon: bold, italic, and underlined 

text; justification and indents; and so on.  

To adjust formatting at the “Paragraph” level, look for a dropdown menu in the lower left 

corner of the “Modify Style” box. It will say “Format” by default, but if you click on it, you’ll see 

additional options, each representing a group of formatting commands. Select “Paragraph” by 

clicking on it in this list of options. The buttons pertaining to font formatting will disappear, 

replaced by new options for paragraph formatting (which will look like the paragraph formatting 

box that appears if you click on the “Format” menu and select “Paragraph…”). 

Table 3.1 shows several of the most important Styles for music theses and their settings for 

font and paragraph formatting. It is recommended that you use Table 3.1 to set up your Styles. 

 

Style Name Used For General Settings Font Formatting Paragraph Formatting 
Normal the body text of 

your thesis 
Style for following 
paragraph: Normal 

Times New Roman, 
12-point size, black 
color 

Alignment: justified 
Outline level: body text 
Indentation: 

Left 0” 
Right 0” 
Special: First Line by 

0.5” 
Spacing: 

Before: 0 pt 
After 0 pt 
Line Spacing: double 

Heading 1 
 
see additional 

settings below 

chapter titles Style Based On: 
Normal 

Style for Following 
Paragraph: 
Normal 

Times New Roman, 
12-point size, black 
color 

Alignment: centered 
Outline level: level 1 
Indentation: 

Left 0” 
Right 0” 
Special: (none) 

Spacing: 
Before: 0 pt 
After 12 pt 
Line Spacing: double 
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Style Name Used For General Settings Font Formatting Paragraph Formatting 
Heading 2 titles of sections 

within a chapter 
Style Based On: 

Normal 
Style for Following 

Paragraph: 
Normal 

Times New Roman, 
12-point size, black 
color 

Alignment: centered 
Outline level: level 2 
Indentation: 

Left 0” 
Right 0” 
Special: (none) 

Spacing: 
Before: 24 pt 
After 12 pt 
Line Spacing: double 

Heading 3 additional levels 
of organization 
within the body 
text 

Style Based On: 
Normal 

Style for Following 
Paragraph: 
Normal 

Times New Roman, 
12-point size, black 
color 

Alignment: justified 
Outline level: level 3 
Indentation: 

Left 0” 
Right 0” 
Special: (none) 

Spacing: 
Before: 12 pt 
After 0 pt 
Line Spacing: double 

Block Quote lengthy 
quotations 

Style Based On: 
Normal 

Style for Following 
Paragraph: 
Normal 

Times New Roman, 
12-point size, black 
color 

Alignment: justified 
Outline level: body text 
Indentation: 

Left 0.5” 
Right 0.5” 
Special: (none) 

Spacing: 
Before: 12 pt 
After 12 pt 
Line Spacing: single 

Caption descriptive text 
beneath figures, 
tables, etc. 

Style Based On: 
Normal 

Style for Following 
Paragraph: 
Normal 

Times New Roman, 
12-point size, black 
color 

Alignment: justified 
Outline level: body text 
Indentation: 

Left 0.5” 
Right 0” 
Special: (none) 

Spacing: 
Before: 0 pt 
After 24 pt 
Line Spacing: single 

Footnote Text the text of your 
footnotes 

Style Based On: 
Normal 

Style for Following 
Paragraph: 
Footnote Text 

Times New Roman, 
10-point size, black 
color 

Alignment: justified 
Outline level: body text 
Indentation: 

Left 0” 
Right 0” 
Special: Hanging by 

0.25” 
Spacing: 

Before: 0 pt 
After 12 pt 

Line Spacing: single 
Table 3.1. Style settings 
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The “Heading 1” Style requires a little more configuration: Because captions and the table 

of contents depend on the number of each chapter, when modifying this Style, you should also 

select the group of settings called “Numbering…” using the dropdown menu in the lower left 

corner of the “Modify Style” box. Then, go to the “Outline Numbered” tab and select the option 

on the lower right. This will add “Chapter” (you may need to change it to all caps) and a number 

each time you apply the Style. 

Applying a Style 

You can apply a Style by placing your cursor where you want it to be used, opening the 

“Style” box or “Styles Pane” as described above, selecting the Style you wish to apply, and clicking 

on the button that says “Apply.” If you’ve already written some text and you want to apply a Style 

to it, simply select that text before opening the Style box. When you apply a Style to an empty line 

(or paragraph), it affects all the text you subsequently write there until you place a paragraph break. 

General Formatting of Your Document 

These formatting guidelines apply to your entire document, unless an exception is noted: 

Margins and Orientation 

The margins for your entire document must be 1” (one inch) on all sides of the 8½-by-11-

inch page. All pages must be in “portrait” orientation, with the eleven-inch sides of the page on 

the left and right. The WSU Graduate School does not allow pages in “landscape” orientation. 

Font, Size, and Color 

All text in your thesis must be set in Times New Roman font, size 12, and in black ink 

color. However, 10-point font may be used for footnotes and textually dense tables. 
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Be sure to follow the common conventions for writing titles of musical works and other 

works of art. Titles of larger works (books and journals, albums, operas, plays, films, collections, 

etc.) are italicized without quotation marks. Titles of shorter works or parts of larger works 

(articles, chapters, songs, arias, episodes, etc.), as well as titles of theses and dissertations, are 

placed in quotation marks but not italicized. Generic titles, such as “Symphony No. 40,” are neither 

italicized nor placed in quotations marks.4 

Spacing 

All text must be double-spaced, except for block quotes, captions, footnote text, and certain 

instances of your thesis’ title. No additional space should be added before or after paragraphs in 

the body text of the document (in Table 3.1, the Style “Normal”). However, certain other 

elements—including headings, captions, footnotes, etc.—may include additional space before or 

after. 

Breaks and Sections 

In Word, a “break” is any separation of text from what came before it. When you finish 

writing a paragraph and press the “enter” or “return” key, you are in fact inserting a paragraph 

break. If you insert a page break—by going to the “Insert” menu, selecting “Break,” and clicking 

on “Page Break”—it moves all subsequent text to the top of the next page. If you have turned on 

the ability to see formatting marks (see “Showing Formatting Marks”), you’ll be able to see all the 

breaks in your document. 

                                                 
4 For additional details, see Kate L. Turabian, A Manual for Writers of Research Papers, Theses, and Dissertations, 

9th ed. (Chicago: University of Chicago Press, 2018), 326–8. 
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A section break separates parts of a large document into sections. This is useful when you 

want certain formatting to apply only within part of the document, such as when you must change 

the location and format of the page numbers. Moreover, if each chapter of the thesis is its own 

section, then you can start numbering footnotes with “1” at the beginning of each. 

There are several different kinds of section breaks, depending on how you want your text 

to flow on the page or across pages. A next page section break places all subsequent text at the 

top of the next page and starts a new section. A continuous section break starts a new section but 

doesn’t force the text to begin at the top of the next page. Even page and odd page section breaks 

create new sections that begin at the next even or odd page number, respectively. All these breaks 

can be inserted into your document by clicking on the “Insert” menu, then on “Break,” and then 

on the type of break you want. Section breaks can also be added to your document by clicking on 

the “Breaks” button in the “Layout” tab of the ribbon.5 

In your thesis, it is recommended that each part of the document—parts within the front 

matter, each individual chapter, and parts of the back matter—be its own section, in the technical 

sense. Practically speaking, this means inserting a next page section break at the end of each of the 

document’s parts. 

Page Numbers 

Page numbers appear on most pages of the thesis and help readers keep the pages in 

logical, sequential order, while also allowing the table of contents to meaningfully refer to specific 

                                                 
5 For more information about working with sections in Word, see https://support.microsoft.com/en-gb/office/use-

section-breaks-to-change-the-layout-or-formatting-in-one-section-of-your-document-4cdfa638-3ea9-434a-8034-
bf1e4274c450. 

https://support.microsoft.com/en-gb/office/use-section-breaks-to-change-the-layout-or-formatting-in-one-section-of-your-document-4cdfa638-3ea9-434a-8034-bf1e4274c450
https://support.microsoft.com/en-gb/office/use-section-breaks-to-change-the-layout-or-formatting-in-one-section-of-your-document-4cdfa638-3ea9-434a-8034-bf1e4274c450
https://support.microsoft.com/en-gb/office/use-section-breaks-to-change-the-layout-or-formatting-in-one-section-of-your-document-4cdfa638-3ea9-434a-8034-bf1e4274c450
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points in the document. See “Parts of the Thesis” for more information about the parts of a thesis 

and the order in which they appear in the document. 

The dedication, acknowledgments, preface, table of contents, and lists of tables and/or 

figures are numbered consecutively in lower-case Roman numerals at the bottom center of each 

page, starting with “ii”. The copyright page (if included) is not numbered. 

Within the body text of your thesis, use Arabic numbers beginning with “1” on the first 

page of the text and continuing throughout the end of the manuscript. The page numbers should 

be located at the top center of the page, within the top margin, approximately 0.5” from the edge 

of the page. 

Page numbers appear in either the header or the footer of your document. A header is the 

area inside the margin at the top of every page, while a footer is the area inside the margin at the 

bottom of every page.6 To access your document’s header and footer, you can either double-click 

in the header or footer space, or, alternatively, go to the “View” menu and click on “Header and 

Footer.” Once opened, you can add and remove text from the header and footer, format it, and so 

on. When the header and footer are open, a new tab of buttons appears in the ribbon, aptly titled 

“Header and Footer.” 

Before inserting page numbers in Word, make sure you’ve added section breaks at the end 

of each chapter and at the end of the front matter. Page numbers can continue from one section to 

another, but they don’t have to—this is how you can switch from lower-case Roman numerals for 

the front matter of your thesis to Arabic numerals for its body. For page numbering to continue 

from a previous section, open the header and footer and look for the button in the “Header & Fitter” 

                                                 
6 Footers shouldn’t be confused with footnotes: footers appear at the bottom of every page (or until you change them), 

whereas a footnote only appears at the bottom of a particular page—like this one. 
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ribbon that says, “Link to Previous.” Oftentimes it’s on by default, but if it’s not, you can turn it 

on by clicking on the button. When it’s on, the current section will follow whatever headers or 

footers—which contain the page numbers—appear in the previous section. (For more on section 

breaks, see “Breaks and Sections.”) 

You can insert page numbers in Word in two ways. The first is simpler, but in my experience 

doesn’t always work well: open the “Insert” menu and click on “Page Numbers…” In the “Page 

Numbers” box, select the location where you want the page numbers to appear. By click on the 

“Format…” button, you can adjust the number format and, more importantly, whether the number 

continues from the previous section or starts over from a particular number you specify. A variant 

of this method, page numbers can also be placed by double-clicking in the header or footer of a 

page (or going to the “View” menu and selecting “Header and Footer”) and, in the “Insert” tab of 

the ribbon, clicking on the “Page Number” button. 

The second method is slightly more complicated but, I’ve found, can actually be more 

effective and need less tinkering to get things looking right. The crucial thing about this method is 

that it inserts a field, a placeholder for information (in this case, a page number), into your 

document rather than an actual character of text.7 First, open the header or footer and place your 

cursor where you want the page number to appear. Before inserting any text, format it properly by 

confirming the correct font, size, color, and centered justification (which is required by the 

Graduate School). Then, go to the “Insert” menu and click on “Field…” In the “Field” box, under 

“Categories,” select “Numbering.” Then, under “Field Names,” select “Page.” To specify the 

format of the numbers (i.e., lower-case Roman numerals or regular Arabic numerals), click on 

                                                 
7 For more information about fields in Word, see https://support.microsoft.com/en-gb/office/insert-edit-and-view-

fields-in-word-c429bbb0-8669-48a7-bd24-bab6ba6b06bb. 

https://support.microsoft.com/en-gb/office/insert-edit-and-view-fields-in-word-c429bbb0-8669-48a7-bd24-bab6ba6b06bb
https://support.microsoft.com/en-gb/office/insert-edit-and-view-fields-in-word-c429bbb0-8669-48a7-bd24-bab6ba6b06bb
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“Options…”, select the format you want, and click “Add to Field.” Click “OK” to exit the 

“Options” and “OK” to exit the “Field” box. Your page number should now be visible in your 

document and will continue to appear in the same place on every page until you “unlink” a section 

from the previous one.8 

Chapter Titles 

Chapter titles appear at the beginning of each chapter of the thesis. Typically, it has two 

parts, the word “CHAPTER” followed by the chapter number, and on the next line, contains a 

descriptive title of the chapter.9 Each chapter begins at the top of a new page—chapters don’t start 

in the middle of a page—so it is recommended that each chapter end with a next page section 

break. See “Sections and Breaks” for details. 

Chapter titles should be centered and bold, followed by a 12-point space to separate it from 

the body text or heading that follows. In Table 3.1, chapter titles use the Style “Heading 1.” 

Headings and Subheadings 

Headings are brief phrases of text that break up a chapter into discrete portions, often for 

the purpose of organizing the argument and giving each portion its own descriptive title. Headings 

offer visual breaks between portions, but don’t begin at the top of a new page (unless that’s how 

the text of the document naturally flows). 

Headings should be centered but not bold, with a 24-point space before and a 12-point 

space after to separate it from the body text. In Table 3.1, headings use the Style “Heading 2.” 

                                                 
8 For more information about working with page numbers in Word, see https://support.microsoft.com/en-

us/office/page-numbering-in-word-5a12ea00-be26-4c88-8802-797bd53f71a9.  

9 In order to avoid creating a second Heading 1, press shift-return (or shift-enter) at the end of the phrase “Chapter X.” 
That will start the subsequent text—the descriptive title of your chapter—on the next line without starting a new 
Style. 

https://support.microsoft.com/en-us/office/page-numbering-in-word-5a12ea00-be26-4c88-8802-797bd53f71a9
https://support.microsoft.com/en-us/office/page-numbering-in-word-5a12ea00-be26-4c88-8802-797bd53f71a9
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If you wish to further organize the text within a portion of a chapter under a heading, you 

can use “subheadings.” These are visually distinct from—and subordinate to—headings. 

Subheadings should be fully justified (starting at the left margin), with a 12-point space above 

them to separate them from the preceding text. In Table 3.1, headings use the Style “Heading 3.” 

Block Quotes 

Block quotes are used when a quotation takes up four or more lines on the page. Unlike a 

regular quotation that appears within the text, a block quote is not surrounded by quotation marks. 

Instead, the fact that it comes from an outside source (and therefore contains words that aren’t 

yours) is indicated by larger margins on the left and right sides. 

A block quote should have indentations of 0.5” on both the left and right sides, be single-

spaced, and have a 12-point empty space above and below to separate it from the rest of the body 

text. In Table 3.1, block quotes use the Style “Block Quote.” 

Footnotes 

Footnotes are short passages of text that cite the sources of information referenced in the 

text, to provide additional references the reader might find helpful, and/or to offer additional 

information or commentary (a “narrative” footnote). Each footnote has a number, which appears 

in the body text in superscript and corresponds to an identically numbered note at the bottom of 

that page. All footnotes should follow the Chicago/Turabian style (notes-bibliography version).10 

The use of “Ibid.” is discouraged as its reference may become unclear if text, including the 

                                                 
10 The Chicago/Turabian style comprises two versions. The Department of Music uses the notes-bibliography version, 

which employs footnotes at the bottom of the page and a bibliography at the end of the document. (Indeed, this 
document is written using the notes-bibliography version.) In contrast, the author-date version uses citations inside 
parentheses within the body text, plus a slightly different format for a “reference list.” See Turabian, A Manual 
for Writers of Research Papers, Theses, and Dissertations. 
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footnote, is moved elsewhere in the document during the editing and revision process. Endnotes 

are not used in music theses. 

Always use Word’s built-in footnote command to create footnotes, as it will keep each note 

on the correct page and in the correct order. Click on the “Insert” menu and select “Footnote…” 

In the “Footnote and Endnote” box, you can adjust the note settings. For music theses, use Arabic 

numerals (1, 2, 3, etc.) at the bottom of the page. For numbering, change the default (“continuous”) 

to “Restart Each Section” and apply to the whole document. That way the notes for each chapter 

will begin at “1.” (Note: you must also create sections in your document!) Within each chapter, 

footnote numbers always rise sequentially; in other words, numbers are not repeated. Finally, the 

first reference to a source in each chapter should use the complete citation; subsequent references 

to the same source within the same chapter may use the shortened version. 

Footnote text should be 10-point and single spaced, with a 0.25” hanging indent and a 12-

point empty space after to separate it from the next footnote. In Table 3.1, footnote text uses the 

“Footnote Text” Style. 

Figures, Tables, and Captions 

Figures are images used to illustrate or demonstrate claims made in your thesis or to 

present data. These images may be photos or drawings or graphs, but in music, they often also 

include excerpts from musical scores. Tables are graphically organized pieces of text, such as 

Table 3.1, and are used when prose descriptions would be unnecessarily lengthy. Both figures and 

tables must be properly formatted, numbered, and captioned. 

Figures and tables should be centered horizontally, between the left and right margins on 

the page. Under no circumstances should the table or figure spill over into the margins. This means 

that the maximum width cannot exceed the 6.5”. If your figure is too large, it can be adjusted 
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within Word—just be sure to change the width and height proportionally to avoid distorting the 

image. Tables, too, can be adjusted for size. Leave an empty line (equivalent to a 12-point space) 

before the figure or table and after the caption.11 These spaces help to separate the figure or table 

from the body text that surrounds it. 

If your figure contains an excerpt from a musical score—especially if you’ve annotated it 

with circles, lines, or other shapes layered on top—it should be prepared properly. Use a high-

quality scan from the score or transcribe it using notation software (available in the Department of 

Music computer lab). To help make your points clear, only include the parts of the score that are 

truly necessary.12 Save the image as a PDF file (.pdf).13 If adding annotations, be sure to save them 

with the PDF file—it is recommended that you not add annotations using Word, as they don’t 

always move with the image when text around it moves. To insert a figure into your document, 

place the cursor where you want it to go. Open the “Insert” menu, and go to “Pictures,” and select 

“Picture from File…” Then you can select the file containing your image.14 You may then need to 

                                                 
11 If a heading or subheading immediately follows the figure or table (and you are using the Styles as specified in 

Table 3.1), then you can omit the empty line below the caption as the heading/subheading Style includes such 
space. 

12 Any reproduction of a copyrighted work must be permitted by the copyright holder, or comply with “fair use” and 
must properly credit the creator(s) of the work. For more information about fair use from the U.S. Copyright 
Office, see https://www.copyright.gov/fair-use/. For additional information about fair use from the Stanford 
University Libraries, see https://fairuse.stanford.edu/overview/fair-use/. 

13 While Word can import images saved in other formats, the Adobe PDF (portable document format) is the most 
reliable way to ensure that the image looks the same on nearly any device. Most apps can save files in the PDF 
format. From the Microsoft Office suite, you may find it useful to prepare images for your figures using 
PowerPoint and then saving the file (perhaps as individual slides) as a PDF. For more information about how to 
save Office files as PDFs, see https://support.microsoft.com/en-gb/office/save-or-convert-to-pdf-or-xps-in-office-
desktop-apps-d85416c5-7d77-4fd6-a216-6f4bf7c7c110. WSU also recommends Canva for the creation of 
images, which can be saved and exported in PDF format (see https://www.canva.com/). For more recommended 
online tools, see https://gradschool.wayne.edu/students/online-tools. 

14 For more information about working with images in Word, see https://support.microsoft.com/en-gb/office/insert-
pictures-3c51edf4-22e1-460a-b372-9329a8724344.  

 

https://www.copyright.gov/fair-use/
https://fairuse.stanford.edu/overview/fair-use/
https://support.microsoft.com/en-gb/office/save-or-convert-to-pdf-or-xps-in-office-desktop-apps-d85416c5-7d77-4fd6-a216-6f4bf7c7c110
https://support.microsoft.com/en-gb/office/save-or-convert-to-pdf-or-xps-in-office-desktop-apps-d85416c5-7d77-4fd6-a216-6f4bf7c7c110
https://www.canva.com/
https://gradschool.wayne.edu/students/online-tools
https://support.microsoft.com/en-gb/office/insert-pictures-3c51edf4-22e1-460a-b372-9329a8724344
https://support.microsoft.com/en-gb/office/insert-pictures-3c51edf4-22e1-460a-b372-9329a8724344
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crop the image, removing unnecessary parts, by selecting it and then, in the “Picture Format” tab 

of the ribbon, click on the button that says, “Crop.” Adjust the borders and then click “Crop” again 

to exit the cropping tool. Additional formatting options are available by right-clicking on the image 

and selecting “Format Picture…” 

To insert a table into your document, place the cursor where you want it to appear. Then go 

to the “Table” menu, select “Insert,” and click on “Table…” In the “Insert Table” box, you can 

specify the number of rows and columns (although you can always add or delete these later) and 

several other options. By right-clicking on the table and selecting “Table Properties…”, you can 

also designate a row as the “header row,” have it appear at the top of each page if the table spans 

multiple pages, change the cell borders and margins, etc.15 If your table is especially dense with 

text, you may change the font size to 10-point. And like figures, leave an empty line (equivalent 

to a 12-point space) above the table and below the caption to separate it from the body text. 

Figures and tables are numbered separately within each chapter. The numbering scheme 

indicates the chapter to which the figure belongs, followed by a period, then the sequential number 

within the chapter. Thus, the first figure to appear in chapter three of your thesis would be 

numbered 3.1. The third figure to appear in chapter four would be captioned “Figure 4.3.” If 

chapter three also contains a table, and that table comes after Figure 3.1 in the text, it will still be 

captioned “Table 3.1” (not “Table 3.2”) because figures and tables are numbered separately. 

A caption is a brief textual description of the figure or table that includes the figure or table 

number. In Word, captions can be set to automatically include the correct number. This is helpful 

                                                 
15 For more information about working with tables in Word, see https://support.microsoft.com/en-gb/office/insert-a-

table-a138f745-73ef-4879-b99a-2f3d38be612a. 

 

https://support.microsoft.com/en-gb/office/insert-a-table-a138f745-73ef-4879-b99a-2f3d38be612a
https://support.microsoft.com/en-gb/office/insert-a-table-a138f745-73ef-4879-b99a-2f3d38be612a
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if, while editing and revising your thesis, figures and/or tables are moved between pages, sections, 

or even chapters. Word will automatically update the figure or table with the correct, new number.16 

To add a caption to a figure or table, first select it. Then go to the “Insert” menu and click 

on “Caption…” You can type the text of your caption right into the “caption” box. Under 

“Options,” you should select the proper label for your item: figure or table. Then, by clicking on 

“Format…”, you can make sure Word uses Arabic numerals, includes the chapter number, and 

separates the chapter number from the figure/table number with a period. 

Captions should be indented by 0.5”, single-spaced, and followed by a 24-point space. In 

Table 3.1, caption text uses the “Caption” Style. 

Formatting for Specific Parts of the Thesis 

These formatting guidelines apply to specific elements of your thesis document. 

Title Page 

The title of the manuscript must be all in capital letters and single-spaced. The author’s 

name, also all in capital letters, must be identical on the title page, copyright page (if included), 

and the abstract. The contents should be centered vertically on the page. To center the page contents 

vertically, open the “Format” menu and click on “Document…” Within the “Document” box, 

select the “Layout” tab, where you’ll see, in the section labeled, “Page,” the option “Vertical 

Alignment.” Select “Centered” from the dropdown menu. Make sure that “Apply To” is set for 

                                                 
16 For more information about working with captions in Word, see https://support.microsoft.com/en-gb/office/add-

format-or-delete-captions-in-word-82fa82a4-f0f3-438f-a422-
34bb5cef9c81#:~:text=On%20the%20Captions%20dialog%20box,to%20automatically%20add%20captions%2
0to. 

https://support.microsoft.com/en-gb/office/add-format-or-delete-captions-in-word-82fa82a4-f0f3-438f-a422-34bb5cef9c81#:%7E:text=On%20the%20Captions%20dialog%20box,to%20automatically%20add%20captions%20to
https://support.microsoft.com/en-gb/office/add-format-or-delete-captions-in-word-82fa82a4-f0f3-438f-a422-34bb5cef9c81#:%7E:text=On%20the%20Captions%20dialog%20box,to%20automatically%20add%20captions%20to
https://support.microsoft.com/en-gb/office/add-format-or-delete-captions-in-word-82fa82a4-f0f3-438f-a422-34bb5cef9c81#:%7E:text=On%20the%20Captions%20dialog%20box,to%20automatically%20add%20captions%20to
https://support.microsoft.com/en-gb/office/add-format-or-delete-captions-in-word-82fa82a4-f0f3-438f-a422-34bb5cef9c81#:%7E:text=On%20the%20Captions%20dialog%20box,to%20automatically%20add%20captions%20to
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“This Section.” (See “Breaks and Sections” for more about sections.) The title page is not 

numbered. See Figure 3.1 for a sample title page. 

 

 

Figure 3.1. Sample title page. 
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Copyright Page 

The copyright page is optional. If you choose to add it, then it should include the copyright 

symbol (©), the phrase “copyright by” in bold caps, your name in bold caps, the year in bold caps, 

and the phrase “All Rights Reserved” in bold. The text should be centered on the page, vertically 

and horizontally. (See “Title Page” for instructions for centering text on the page vertically.) The 

page is not numbered. See Figure 3.2 for a sample copyright page. 
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Figure 3.2. Sample copyright page. 

Dedication, Acknowledgments, and Preface or Foreword 

If included, these sections should have a title centered at the top of the page in bold and all 

caps (e.g., “DEDICATION”). Otherwise, the formatting is up to you, provided the font size and 

color, and the margins, remain as required. If you are using the Styles feature in Word, you should 
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apply the same Style to these titles as you do to your chapter titles.17 See “Introducing Styles” for 

more information on Styles. 

Table of Contents 

The required table of contents lists all the preliminary pages (front matter) except for the 

title, copyright, and table of contents pages. In cases where there are two or more appendices, list 

each appendix and its content. The table of contents must also list the bibliography, abstract, and 

autobiographical statement pages, and the page numbers on which they are found. A “leader” of 

periods (dots) connects the titles of each item in the list (left justified) with its respective page 

number (along the right margin). 

Creating a table of contents in Word is straightforward if you’re using Styles to mark your 

chapter titles and headings (see “Introducing Styles” for more information). To create a table of 

contents, place the cursor on the page where it should appear. Then open the “Insert” menu and 

click on “Index and Tables…” In the “Index and Tables” box, select the “Table of Contents” tab. 

From there you can customize the table of contents. (You may need to modify the look of your 

table of contents, after you have created it, by reformatting it to match the requirements of the 

thesis.) Make sure “Show page numbers,” “Right align page numbers,” and “Use hyperlinks 

instead of page numbers” are all checked. That way, the table can be updated with a just a few 

clicks if you make changes later. (In fact, updating the table of contents should be one of the last 

things you do before submitting the file.) You should also confirm that the “Tab leader” is set to 

dots (periods). See Figure 3.3 for a sample table of contents from a recent music thesis. 

 

                                                 
17 You may need to manually remove the word “chapter” and the automatic chapter number, as these sections aren’t 

really chapters. 
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Figure 3.3. Sample table of contents. 

Lists of Tables, Figures, etc. 

If tables, figures, or similar graphic representations are used in the thesis (not including the 

appendix), you need to create a List of Tables, List of Figures—or even both—following the table 

of contents page. Each entry on the list should carry the same caption or title as is shown in the 
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caption for the corresponding figure or table in the text, and show, at the right margin, the page on 

which it is found (similar to the table of contents). 

Creating a list of figures or tables is straightforward if you’re using Word’s caption feature 

for each of your figures and tables (see “Figures, Tables, and Captions” for more information). To 

create a list of tables or figures, place the cursor on the page where your list should appear. Then 

open the “Insert” menu and click on “Index and Tables…” In the “Index and Tables” box, select 

the “Table of Figures” tab. In the “Caption Label” area, choose the “label” on which your list will 

be based: “Figure” for a List of Figures, “Table” for a List of Tables, etc. Then you can customize 

the list. (You may need to modify the look of your list, after you have created it, by reformatting it 

to match the requirements of the thesis.) Make sure “Include label and number,” “Show page 

numbers,” “Right align page numbers,” and “Use hyperlinks instead of page numbers” are all 

checked. That way, the table can be updated with a just a few clicks if you make changes later. (In 

fact, updating these lists should be among the last steps before submitting your thesis.) You should 

also confirm that the “Tab leader” is set to dots (periods). See Figure 3.4 for a sample List of 

Figures from a recent music thesis. 
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Figure 3.4. Sample list of figures. 

The Body of the Thesis 

The Graduate School requires only that the body text of the thesis be fully justified, and 

that chapter text begins immediately following the chapter title (not on a separate page). The 

Department of Music adds additional requirements for the formatting of the body of the thesis, 

including chapter titles, headings, block quotes, footnotes, citation methods, figures and tables, 
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and the bibliography (see “General Formatting of Your Document,” above, for more information). 

For a discussion of the content of the thesis chapters, see “Writing and Revising Chapters.” 

Appendix 

The format of the appendix is mostly unspecified; you can include whatever content you 

like in almost any manner you desire. You may use more than one appendix if you wish; simply 

title them “Appendix A, B, C, etc.” and format them like a chapter title. The information begins 

right after title (not on a separate page). 

Bibliography 

The bibliography of your thesis lists all the sources cited in your text. (There is no need 

to include books or articles that you read but didn’t actually cite anywhere in the document.) Your 

bibliography must be formatted according to the Chicago/Turabian style (notes-bibliography 

version). Pay careful attention to both the information required and the order in which it should be 

presented in each bibliographic entry. Bibliographies are ordered alphabetically by author’s last 

name. They are not numbered or bulleted. 

Bibliography entries use a hanging indent, in which the first line is not indented but all 

subsequent lines are. You can create a hanging indent by placing the cursor on the line with the 

entry (or selecting all the entries), going to the “Format” menu, and clicking on “Paragraph…” In 

the “Indentation” section of the “Paragraph” box, you’ll see the option for “Special” kinds of 

indents. Choose “Hanging” from the dropdown menu and set it so it hangs by 0.5”. 

See Figure 3.5 for a sample page from a recent music thesis. 
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Figure 3.5. Sample bibliography. 

Abstract 

While there’s no limit to the length, most abstracts contain no more than five hundred 

words. The title of your thesis appears at the top of the abstract, formatted the same as on your title 

page. Additional required information includes your name, the month and year of your graduation, 

your Thesis Advisor’s name, your major (Music), and degree (Master of Arts). The remaining text 
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of the abstract is formatted the same as the body text. The abstract is a required part of the thesis. 

See Figure 3.6 for a sample abstract from a recent music thesis. 

 

 

Figure 3.6. Sample abstract. 
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Autobiographical Statement 

This required section may be formatted however you see fit (save for the title at the top, 

which must be formatted the same as the chapter titles), but it can only be one page, maximum. It 

must also be the last page of your thesis document. 

Links, Cross-References, and Other Matters of Connectivity 

In recent years, the method(s) by which scholarship is shared has become increasingly 

digital. (You may find yourself sharing your completed thesis with others as a PDF file, for 

example.) At the same time, greater and greater amounts of scholarship and scholarly resources 

are available via the Internet, and the “URL” (“universal resource locator”) and “link” (or 

“hyperlink”) have become a well understood elements of twenty-first century writing. Moreover, 

the concept of clicking on a link, a string of text that will take you somewhere else, has also 

become well understood and, perhaps in some situations, even expected. 

Links to Websites and Other Internet Resources 

The idea of embedding a connection directly from your document to another source is a 

powerful one that you may choose to embrace. However, links are no substitute for good 

scholarship or good writing. A chapter filled with links to websites doesn’t necessarily demonstrate 

deep and critical thinking, or convincing argumentation. Therefore, it is recommended that you 

use links sparingly in your body text. On the other hand, links may be more freely used in 

footnotes, where they function as secondary, subordinate information that doesn’t distract from the 

flow of the text. 

To create a link to a website in Word, select the text you will use as the link. Then, go to 

the “Insert” menu and click on “Hyperlink…” In the “Insert Hyperlink” box that appears, you can 
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edit the text that appears on the page as well as choose between three kinds of destinations for 

when a reader clicks on that text. Select the first tab, “Web Page or File,” and place the URL to 

which you want your reader taken in the box just below.18 In your body text, the link will appear 

underlined and blue—this is acceptable, even though the text of your thesis should be black. 

Cross-References: Links Within Your Thesis 

Another kind of connection you may wish to utilize is the cross-reference. In Word, a 

cross-reference is a string of text (a few words) that refers to another location in the document. 

Cross-references can, themselves, be configured as links so that a reader can click on the phrase 

and go directly to the location being referenced. For example, if you mention something about 

Figure 3.1 in the middle of chapter four, you can make the words “Figure 3.1” into a cross-

reference; a reader who clicks on those words would immediately be taken to the page on which 

Figure 3.1 appears. For cross-references like this to work, you must use Word’s caption function. 

To insert a cross-reference into your text, place the cursor in the spot where you’d like it to 

appear. Then, go to the “Insert” menu and click on “Cross-reference…” The “Cross-Reference” 

box will appear. First, select the “reference type,” which for music theses is typically a figure or a 

table, but headings and footnotes are also among the options. Second, you can choose which text 

will appear on the page as the cross-reference. In most cases, for music theses, you should select 

“Only Label and Number.” Third, to make the cross-reference a clickable link, check the box that 

                                                 
18 For more information about links in Word, see https://support.microsoft.com/en-gb/office/create-or-edit-a-

hyperlink-5d8c0804-f998-4143-86b1-1199735e07bf . Links can also be created by simply typing a URL into your 
document. Alternatively, you may “click here” or a descriptive phrase as the text of the link. 

 

https://support.microsoft.com/en-gb/office/create-or-edit-a-hyperlink-5d8c0804-f998-4143-86b1-1199735e07bf
https://support.microsoft.com/en-gb/office/create-or-edit-a-hyperlink-5d8c0804-f998-4143-86b1-1199735e07bf
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says, “Insert as hyperlink.” Finally, select the specific reference your cross-reference will point to 

from the list.19 

Cross-references to headings can also be inserted into your document using the “Insert 

Hyperlink” function discussed above. Instead of selecting the tab for “Web Page or File,” select 

“This Document.” You can then choose from the headings in the list. 

                                                 
19 For more information about cross-references in Word, see https://support.microsoft.com/en-us/office/create-a-cross-

reference-300b208c-e45a-487a-880b-a02767d9774b. 

https://support.microsoft.com/en-us/office/create-a-cross-reference-300b208c-e45a-487a-880b-a02767d9774b
https://support.microsoft.com/en-us/office/create-a-cross-reference-300b208c-e45a-487a-880b-a02767d9774b
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CHAPTER 4  

Checklists 

The WSU Graduate School format checklist for theses and dissertations comes from the 

Graduate School’s Dissertation and Thesis Format Guidelines (see Figure 4.1). 

 

 

Figure 4.1. WSU Graduate School format checklist 
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The Department of Music Thesis Formatting Checklist includes the Graduate School’s 

requirements and adds those specific to music (see Table 4.1): 

Department of Music Thesis Formatting Checklist 

Research Requirements 
 

(see “Writing a Thesis Proposal”) 

 research question is defined, and significance is justified 
 sources are appropriate in nature in sufficient in number 
 analytical/research methods are defined and justified 
 thesis statement is clear 

Content Requirements 
 

(see Table 1.2) 

 first chapter: general introduction, research question, thesis statement, 
literature review, methods, and significance 

 middle chapters: data, analyses, and/or other evidence 
 final chapter: recaps, how the thesis adds to current knowledge, impact 

of the conclusions, and suggestions for future research 

Matters of 
Style 

font, size, 
and color 

 all text in Times New Roman font 
 all text in 12-point size (10-point acceptable for footnotes and tables) 
 all text in black color (links may appear in blue and underlined) 
 all text fully justified, with straight margins on left and right sides 
 titles are formatted correctly using italics or quotation marks 

margins, indents, 
and orientation 

 all margins 1” (one inch) on all sides of the 8½-by-11-inch page 
 first line of each body paragraph is indented by 0.5” (half an inch) 
 all pages are “portrait” orientation; no “landscape” pages 

spacing 

 all text double-spaced (except for block quotes, captions, footnotes, and 
the thesis title on the title page, which are single-spaced) 

 no extra spaces between body paragraphs 
 a blank line (12-point) above and below separates block quotes, figures, 

and tables from the surrounding body text 

chapter titles, 
headings, and 
subheadings 

 each chapter begins with a title, bold and centered at the top of a page 
 chapter titles contain “CHAPTER” followed by the chapter number; an 

optional descriptive title may appear on the following line 
 chapter titles are followed by an empty line (12-point space) 
 headings do not begin at the top of a new page (unless that is how the 

body text naturally flows) 
 headings are centered, but not bold, with a 24-point space before and a 

12-point space after 
 subheadings do not begin at the top of a new page (unless that is how the 

body text naturally flows) 
 subheadings are fully justified, with a 12-point space above 

block quotes 

 used when a quotation takes up four or more lines on the page 
 not surrounded by quotation marks (unless in the quote itself) 
 indented by 0.5” (one half inch) on both left and right sides 
 single-spaced, with an empty line (12-point size) above and below 
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figures, tables, 
and captions 

 figures/tables placed after the first paragraph they are mentioned, with a 
12-point space between the end of the paragraph and the figure/table 

 figures/tables centered horizontally, do not extend into the margins 
 figures containing excerpts from musical scores include only enough of 

the score to serve its purpose, without extra or needless material 
 figures containing excerpts from copyrighted works do so with 

permission from the copyright holder, or within “fair use” and properly 
credit the creator(s) of the works 

 tables that are textually dense may use 10-point size font 
 all figures/ tables are captioned, and all captions are numbered using the 

system described in “Formatting for Specific Parts of the Thesis” 
 captions are indented 0.5” (half an inch) from the left margin and 

include a 24-point space after 

footnotes 

 created using the footnote function in Microsoft Word 
 within each individual chapter, footnote numbers begin with “1” and 

continue sequentially, without reusing any numbers 
 the first reference to a source within a chapter uses the full citation; 

subsequent references to the same source may use the shortened version 
 citations follow the Chicago/Turabian style (notes-bibliography) 
 narrative text (“narrative footnotes”) is as concise as possible 
 single-spaced, using 10-point font size 
 you may insert a 12-point space after each footnote 

page numbers 

 front matter (“preliminary pages”) pages are numbered using lower-case 
Roman numerals at the bottom center, beginning with “ii” (except for 
the title page and copyright page, if included) 

 body text and back matter pages are numbered using Arabic numerals at 
the top center, beginning with “1” 

 
 
 
 
 
 
 

Parts of the 
Thesis 

 
(see 

Table 2.1) 

 
 all required 

parts of the 
thesis are 
present 

 
title page 

 title is single-spaced, bold, and all caps 
 your name is in bold caps 
 line up “MAJOR”, “Approved by”, and 

“Advisor” under the first number of the year 
(centered under the degree) 

 double-spaced throughout (except for title) 
 page is not numbered 

 
table of contents 

 lists all parts of the thesis except title page, 
copyright page (if included), and table of 
contents page 

 corresponding page numbers are right justified, 
with a dotted leader 

 double-spaced 
 page(s) is/are numbered with lower-case 

Roman numerals at the bottom center 
 the body text meets all requirements listed in “Matters of Style,” above 
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bibliography 

 lists all sources cited in body text; lists only 
sources cited in body text 

 title (“Bibliography” or “Works Cited”) format 
matches that of chapter titles 

 bibliographic entries begin immediately below 
the title 

 entries follow Chicago/Turabian style (notes-
bibliography version) 

 entries listed alphabetically by author’s last 
name; not numbered or bulleted 

 entries use a hanging indent 
 no extra space between entries 
 pages are numbered using Arabic numerals at 

top center 
 
abstract 

 summarizes the thesis, methods, findings, and 
significance 

 thesis title appears at the top, formatted the 
same as the title page 

 additional required information is present 
(your name, month and year of graduation 
[without a comma between], Thesis Advisor’s 
name, your major [“Music”], and degree 
[“Master of Arts”] 

 page(s) is/are numbered using Arabic numerals 
at top center 

 
autobiographical 
statement 

 thesis title appears at the top, formatted the 
same as chapter titles 

 no more than one page of text 
 page is numbered using Arabic numerals at top 

center 
 must be the last page of the thesis 

 
 any additional, 

applicable, or 
optional parts 
of the thesis are 
present 

 
copyright page 

 includes the copyright symbol, the phrase 
“copyright by” in bold caps, your name in bold 
caps, the year in bold caps, and the phrase “All 
Rights Reserved” in bold 

 centered horizontally and vertically 
 page is not numbered 

 
dedication, 
acknowledgments, and 
preface or foreword 

 appear in the order: dedication, then 
acknowledgments, then preface/foreword 

 each is titled, top center, in bold and caps 
 page(s) is/are numbered using lower-case 

Roman numerals at bottom center 
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lists of tables, 
figures, etc. 

 required if any tables, figures, etc. appear in 
the body text 

 separate lists for tables, figures, etc. 
 includes only tables/figures/etc. appearing in 

the body text (not the appendix) 
 each item uses same text as its caption 
 corresponding page numbers appear right 

justified, with dotted leader 
 page(s) is/are numbered using lower-case 

Roman numerals at bottom center 
 
appendix 

 multiple appendices are labeled “Appendix A,” 
“Appendix B,” etc. 

 titles are formatted like chapter titles 
 content begins immediately below the title 
 page(s) is/are numbered using Arabic numerals 

at top center 
 
 parts of the thesis are assembled in correct order (see Table 2.1) 
 

Table 4.1. Department of Music thesis formatting checklist 
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